INTE 2014

Innovation in ethical education by means of teachers’ action research

Miroslav Valica, Terezia Rohn*

Miroslav Valica, Faculty of Education, Matej Bel University, Ružová 13, Banská Bystrica, 974 11, Slovakia
Terezia Rohn, Faculty of Education, Matej Bel University, Ružová 13, Banská Bystrica, 974 11, Slovakia

Abstract

In our study we examine the possibilities for using action research by teachers in planning innovative content and methodological changes in ethical education. We propose a model for the creation of an action research project that would enable teachers to effectively plan innovations in their own classes, by means of educational experiment.

© 2014 The Authors. Published by Elsevier Ltd.
Peer review under responsibility of the Sakarya University.

Keywords: ethical education; action research; educational experiment; innovation.

1. Introduction

Ethics teachers think routinely about their teaching and its influence on the cognitive, personal and socio-moral development of pupils. They adapt their teaching to their pupils’ individual peculiarities, educational needs and interests, create favourable conditions for learning, and continually monitor the progress and results of teaching. Based on these factors they draw conclusions, reflect the educational context of the school and flexibly adapt their educational approaches to new conditions and requirements in education. They are reflexive teachers who, in the process of choosing content, teaching strategies and methods, take into account the objectives of ethical education and the need for a structured curriculum, learning activities and tasks, motivation for pupils to learn and the creation of conditions for pupils’ effective social learning, mode of interaction and communication in a class.

* Corresponding author. Tel.: +421 917 103 180
E-mail address: miroslav.valica@umb.sk

1877-0428 © 2014 The Authors. Published by Elsevier Ltd.
Peer-review under responsibility of the Sakarya University.
The teacher of ethics should create his own didactic concept for educational situations based on knowledge of educational theory and its application to educational situations in ethics classes. Its practical application in school practice should be validated by action research based on specific educational phenomena and his idea of "how it should work".

2. Action research in ethical education

Action research originated as a response to the inadequate influence of traditional research on change in practice and as a means of accelerating the necessary changes in practice (Hendl, J., 2008). Those who are affected by these changes actively participate in the creation of them. The research process is a process of learning and change. It is of a liberating nature as it solves the problems of practice in order to improve it.

Innovation in ethical education is linked to the permanent and systematic didactic reflection of a teacher, by way of action research in particular. It means the improvement of his educational activity by more precise, systematic feedback in relation to educational theory and the creation of a personalized teaching concept. Because according to our empirical findings ethics teachers seldom use action research in practice, we would like to point out its potential for the improvement and innovation of teaching and development of their professionalism.

In the Educational dictionary (Prucha J., Walterová E., Mareš J., 2003), action research is characterized as a type of educational research whose purpose is to influence and improve a certain part of the educational practice directly, and it addresses the current needs of educational institutions. It employs intervention strategies, and makes recommendations, which it also tries to implement. It continuously monitors the effects of changes.

Action research is usually short-term and implemented in a smaller research sample (e.g. one school class), and is focused on exploring and solving partial problems, which are not usually dealt with by traditional professional research. The results are applicable immediately, but their usefulness is limited to the studied group (Prucha J., 1995).

Turek (1996, p. 15) says that "action research is the practical research of teachers in the classroom or the kind of educational research carried out by teachers, which responds to current problems in teaching (educational experimentation)." He further states that action research is focused directly on improvement, enhancement, and positive influence on the teaching practice, while its results are immediately used in teaching practice. It is an integral part of the teaching process. According to this author, action research meets the following functions:

- Function of practical research, since its role is to study specific school situations and their positive changes, aimed at an improvement in the quality of education,
- Function of methodological tool, as it is aimed mainly at obtaining systematic knowledge and experience about the teaching processes and pupils’ learning, and at seeking strategies, methods and procedures for the enhancement of teaching,
- Incentive and regulatory functions leading a teacher to self-reflection about his own work with the goal of improving his quality and professionalism.

The action research process can be of a cyclical and reflective nature, which determines the order of individual steps and phases. The cyclical nature of the examination process means that the major steps are repeated in a similar sequence, and reflectivity means that an essential part of each cycle is an evaluation of the process and results of examination.

The basis for the action research process is the teacher's own actions which result from reflection on a particular situation and lead toward a solution. The situation represents the action that the teacher examines and his actions should also lead to improvement of the examined situation.

On the basis of analysis of various approaches, we consider the following procedure – cycle to be appropriate for the planning and implementation of action research in ethical education focused on innovation of teaching (according to Turek I., 1996):

1. Reflection – the teacher thinks about the teaching process, wants to improve it, on the basis of his own experience finds out that some element of the educational process is not as efficient as it could and should be and that it would be possible to implement it better. It is usually a part of the curriculum, teaching method, organization of teaching, method of examination and evaluation of pupils, pupil’s attitude to teaching, subject popularity among pupils and so on. On the basis of such analysis, he chooses the research
**issue** he wants to deal with.

2. **Action research project** – the teacher should obtain detailed information about the selected issue, whether by more detailed study of literature or by consultation with colleagues. The outcome of the project should be an idea of how the innovated teaching will be carried out and how he will proceed in gathering results of the proposed innovation. He should determine a specific **objective (or objectives)** or alternatively research questions, and should determine the **research methods** to be used for the gathering of action research results. As far as possible several methods of data collection should be used to increase the objectivity, credibility and reliability of the research. In the action research plan, the **place of action research**, the research sample, materials needed for action research, schedule of action research, and usage of action research results should be determined.

3. **Action** – teacher implements the proposed plan in practice – he does an action research. He **continuously monitors the innovation’s impact on the progress and results of the teaching process**. It is important to do the research honestly, impartially, responsibly, consistently and not to distort the results. Even the negative results can be a contribution to science, sometimes even more so than the positive results.

4. **Reflection** – the teacher evaluates the results, draws conclusions, **suggests recommendations for problem-solving in teaching practice**. If the results of action research are not convincing, the teacher can specify or extend the issue and repeat the action research. If the results are positive, the innovation will begin to be used in practice and will become a standard, integral part of the teaching process. The teacher suggests further innovation and the whole cycle is repeated.

It is assumed that the ethics teacher can create, implement and evaluate the contribution of action research, i.e. to develop and implement an action research project. He is able to:

- Identify **problems in ethics classes** that he needs to eliminate for better quality of teaching and to find new solutions,
- Create a certain concept of studying the didactical problem in ethics classes, i.e. to set **goals, or research questions** for which he is seeking relevant answers,
- Choose appropriate **methods of research** in order to solve the didactic problem in ethics classes,
- Carry out **educational experiment in the form of action research** in education usually focused on innovation of content, educational strategies and methods, organizational forms in selected thematic units.
- **Analyse and interpret** new experience obtained by employing innovative contents, methods and forms of teaching and **draw conclusions** for his own educational activities, and present the results to the teaching community.

3. Planning action research in ethics classes (General framework)

1. **Reflection**

Action research represents a **controlled and systematic reflection of a teacher focused on the improvement of his educational activities by feedback**. The educational reflection of an ethics teacher on his own teaching process by means of educational experiment enables him to examine the innovation of a new curriculum or a new teaching method or methods in the process of teaching, based on identification of the **research problem**, where the class’s learning results are evaluated (the change in their competence) before and after the experimental application of a new curriculum, methods of active learning, and so on. Research is carried out under real teaching conditions in order to increase efficiency and improve teaching conditions. Action research leads to the suggestions or discoveries and justification of educational content and methods, approaches, educational activities used by a teacher in his teaching.

2. **Action research project in ethics classes by educational experiment**

**Research problem**

Of what benefit is content/methodological innovation to my teaching of ethical education in the thematic unit selected; themes for the development of cognitive, personal, social and moral competence of pupils making use of my own didactic model for ethical education?

Note: The personal, social and moral competence of pupils developed in ethical education is defined in the National Educational Programme. Ethical education for ISCED 1-3, as the Framework Standards – content
(cognitive), socio-affective and conative, for different levels of education, years and thematic units that form the framework for the school educational programme (curriculum, thematic plans and projects for ethics classes); by the specification of standards to learning objectives and content/curriculum that teacher takes into account (pupils’ learning needs, conditions of school, class).

Main objective of research:
To identify the advantage of content/methodological innovation to my ethical education in the development of pupils’ cognitive, personal, social and moral competence in the selected thematic unit, topic, based on the use of my own didactic model of ethical education.

Specific objectives:
1. To determine the level of cognitive, personal, social and moral competence of pupils/class characteristics in my ethics classes at the beginning of the chosen thematic unit, topic, on the basis of using my own didactic model of ethical education.
2. To determine the change in the level of cognitive, personal, social and moral competence of pupils/class characteristics in my ethical education at the end of the chosen thematic unit, topic, on the basis of using my own didactic model of ethical education.

Research questions:
1. What is the level of cognitive, personal, social and moral competence of pupils/class characteristics in my ethics classes at the beginning of the chosen thematic unit, topic, based on employment of my own didactic model of ethical education?
2. To what extent will the level of cognitive, personal, social and moral competence of pupils/class characteristics change in my ethics classes at the end of the chosen thematic unit, topic, on the basis of employing my own didactic model of ethical education?

Place of action research: school

Action research sample: class, chosen pupils, a pupil

Methods of action research: methods for the collecting and processing of research data, analysis and interpretation of research data, findings or justification of their choice

Material resources needed for action research: description of material

3. Action-Tasks (including the time for completing the tasks)
1. To create projects for ethical education focused on innovations in teaching by employi
2. To carry out assessment of pupil’s competences/class characteristics at the beginning of the chosen thematic unit, topics in ethical education by relevant research and diagnostic methods (observation, sociometry, questionnaires, scales, interview, educational case studies, pupil’s portfolio, etc.) according to the target and content orientation in teaching projects innovations.
3. To implement ethical education in selected thematic unit/topic according to the ethical education projects.
4. To make an ethical education analysis after each lesson (pedagogical diary, structured self-evaluation scale of a teacher, etc.).
5. To carry out assessment of pupil’s competences/class characteristics at the end of the chosen thematic unit, topics in ethical education by employment of content/methodological innovation in the selected thematic unit, topic.

4. Reflection
Method of usage of the action research results
Elaboration of an action research report or case study, which the ethics teacher presents to colleagues or publishes in a pedagogical periodical. The core of the research report will consist of: a theoretical framework for research, a research project for action research, projects for ethical education, the presentation and interpretation of results, conclusions and recommendations for teaching practice.
Conclusion

Knowledge and usage of action research increases the ethics teacher’s professionalism, and his self-confidence, because it permits a merging of educational experience with the study of literature and research that is focused on solving his teaching problems. The ethics teacher becomes an innovator – a researcher in his own teaching, which also improves his professional status. He can justify and explain with greater validity, modify, successfully implement and introduce innovations into the teaching of ethical education.

This work was supported by the Agency for Research and Development under contract no. APPV-0690-10.

References

Instructions to Authors for Word template

1. Locking of Copyright:

The copyright line is locked in the Procedia templates. The author may not edit the same and making it editable only PSMs. If there are any copyright changes required, you are requested to contact Journal Manager through Guest Editors. For editable the below mentioned steps must be followed:

Steps:
- Click on copyright statement
- Click on Properties in Developer tab
- Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking and then Press ok

2. Docm format:

We have added macros in the Word templates for the below mentioned features. And since macros are not supported in doc and docx format we created the templates of all Procedia titles in .docm format.

- Removal of all highlights
- Accept track change
- Locking of Rules

If .docm format needs to convert in docx format then the following steps must be performed:

Steps:
- Press Alt F11
- Click on Project (JID_Template)
- Enter "thomson" in Project Password
- Click on Microsoft Word Objects
- Click on ThisDocument under Microsoft Word Objects
- Delete all macros under General
- After deletion close the Code and Project (JID_Template) windows
- From File menu click on save as type .docx option

3. Comments added in the margin in Word master templates:

There are instances where author raising queries on what to do with key information lines such as “volume, page numbers”, “Conference title per issue” and “Copyright entity, year, copyright company Elsevier Ltd./B.V./Inc. and Organizer Name” in the copyright statement and for these concerns the comments have been inserted in the Word template to guide Author/JM about the information to be inserted by them in these fields.

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. If the authors do not want to get the comments appearing in print, the authors must remove the comments from the Word template before printing by changing the Print markup setting of word using the following steps:

Steps:
- Click the File tab
- Click Print
- Under Settings, click the arrow next to Print All Pages
- Click Print Markup to clear the check mark
Instructions to Authors pages to be excluded from Print:
- Click the File tab
- Click Print
- Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the document or the section. For example, type 1, 3, 1-5

4. PDF creation from Word master template:

While creating PDF from Word template the below given steps should be followed to avoid difference in trim size and margins and to avoid decrease in resolution and size of the figure images of the Word template and the PDF created.

Steps in Word 2007 and 2010:
- Click the File tab
- Click Print
- Under Printer tab, select Adobe PDF
- Click Printer Properties link
- Under Adobe PDF Settings tab, click on Edit button
- Click on Images folder under Standard
- Make Downsampling and Compression fields under Color Images and Grayscale Images "Off". And in Monochrome Images field make only Downsampling "Off"
- Then click on OK and given name of the setting in File name tab and click on save
- Then again Under Adobe PDF Settings tab, click on Edit button
- Then click on Color folder
- Choose Leave Color Unchanged option under Color Management Policies tab then click on OK
- Lastly click on OK in Adobe PDF Settings tab
- Click Save As
- Under Save as type, click the arrow next to PDF (*.pdf)
- Click Save

In Word 2003 the PDF can be created by using “Convert to Adobe PDF” symbol in tool bar or the required paper size can be adjusted in the Adobe PDF settings given in the Properties tab on the Print option. Please follow the above steps to avoid decrease in resolution and size of the figure images.

5. Reference styles used in Procedia master templates:

<table>
<thead>
<tr>
<th>Title</th>
<th>Reference style</th>
</tr>
</thead>
<tbody>
<tr>
<td>AASPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>AASRI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>APCBEE Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>EGYPRO</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>FINE</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>IERI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>MATPR</td>
<td>1a Numbered without article titles</td>
</tr>
<tr>
<td>MSPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PHPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PIUTAM</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>Procedia CIRP</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>PROCHE</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROCS</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Format Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>PROENG</td>
<td>1 Numbered</td>
</tr>
<tr>
<td>PROENV</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROEPS</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROFOO</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROMFG</td>
<td>1a Numbered without article titles</td>
</tr>
<tr>
<td>PROTCY</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>PROVAC</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>SBSPRO</td>
<td>5 APA</td>
</tr>
<tr>
<td>SEPRO</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>AQPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>UMKPRO</td>
<td>5 APA</td>
</tr>
</tbody>
</table>